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DO NOT USE THIS PRODUCT IN LIFE SUPPORT SYSTEMS.

LIFE SUPPORT POLICY

ZILOG’S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL COMPONENTS IN LIFE 
SUPPORT DEVICES OR SYSTEMS WITHOUT THE EXPRESS PRIOR WRITTEN APPROVAL OF 
THE PRESIDENT AND GENERAL COUNSEL OF ZILOG CORPORATION. 

As used herein

Life support devices or systems are devices which (a) are intended for surgical implant into the body, or (b) 
support or sustain life and whose failure to perform when properly used in accordance with instructions for 
use provided in the labeling can be reasonably expected to result in a significant injury to the user. A criti-
cal component is any component in a life support device or system whose failure to perform can be reason-
ably expected to cause the failure of the life support device or system or to affect its safety or effectiveness.

Document Disclaimer

©2012 Zilog, Inc. All rights reserved. Information in this publication concerning the devices, applications, 
or technology described is intended to suggest possible uses and may be superseded. ZILOG, INC. DOES 
NOT ASSUME LIABILITY FOR OR PROVIDE A REPRESENTATION OF ACCURACY OF THE 
INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZILOG ALSO 
DOES NOT ASSUME LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT RELATED 
IN ANY MANNER TO USE OF INFORMATION, DEVICES, OR TECHNOLOGY DESCRIBED 
HEREIN OR OTHERWISE. The information contained within this document has been verified according 
to the general principles of electrical and mechanical engineering. 

eZ80, eZ80Acclaim! and eZ80AcclaimPlus! are trademarks or registered trademarks of Zilog, Inc. All 
other product or service names are the property of their respective owners. 

Warning:
 UM024402-0812
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Revision History

Each instance in the Revision History table below reflects a change to this document from 
its previous version. For more details, click the appropriate links in the table.

Date
Revision 
Level Description

Page 
No.

Apr 
2012

01 Original issue n/a

Aug 
2012

02 Added note about jumper settings, replaced figures 4–6, modified Table 2. 4, 9, 
13, 16
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Safeguards

The following precautions must be observed when working with the devices described in 
this document.

Always use a grounding strap to prevent damage resulting from electrostatic 
discharge (ESD).

Caution:
Safeguards  UM024402-0812
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The eZ80AcclaimPlus! Development Kit

Zilog’s eZ80AcclaimPlus! Development Kit, part number eZ80F910300KITG, provides a 
general-purpose platform for creating a design based on the eZ80F91 microcontroller. The 
eZ80F91 MCU, a member of Zilog’s eZ80AcclaimPlus! product family, which offers an 
on-chip EMAC and Flash memory. 

Zilog recommends the eZ80AcclaimPlus! Development Kit for new designs. However, if 
you are already working with Zilog’s eZ80F91 Development Kit (eZ80F910300ZCOG) or 
eZ80F91 Modular Development Kit (eZ80F910200KITG), Zilog recommends the devel-
opment documentation that applies to these kits.

This document provides instructions for setting up and configuring your eZ80AcclaimPlus! 
Development Board and includes schematic diagrams and a discussion of Board features 
and ZDS II. 

The first sections of this document guide you through the following tasks:

• Installing the ZDS II Software and Documentation on page 3

• Installing the USB Smart Cable Driver on page 4

• Installing the FTDI USB-to-UART Driver on page 6

• Connecting the eZ80AcclaimPlus! Development Board to your PC on page 8

• Running the Sample Starter Project on page 10

Further details, including memory configurations, jumper settings and a listing of sample 
projects can be found in Appendix A. eZ80AcclaimPlus! Development Board on page 13.

Figure 1 displays an image of the eZ80AcclaimPlus! Development Board. 

Note:
UM024402-0812  
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Table 1 lists the contents of the eZ80AcclaimPlus! Development Kit.

Figure 1. The eZ80AcclaimPlus! Development Kit

Table 1. eZ80F910300KITG Contents

Item Description Quantity

1 eZ80AcclaimPlus! Development Board 1

2 USB Smart Cable 1

3  6-Circuit Ribbon Cable 1

4 A (male) to Mini-B USB Cable 1

5 ZDS II – eZ80Acclaim! Software and Documentation CD-ROM 1

6 eZ80AcclaimPlus! User Manual (UM0244) 1
The eZ80AcclaimPlus! Development Kit  UM024402-0812



eZ80AcclaimPlus! Development Kit
User Manual

3

Kit Features

The key features of the eZ80AcclaimPlus! Development Kit are listed below. 

• eZ80AcclaimPlus! Development Board, which includes:

– eZ80F91 MCU operating at 50 MHz, with 256 KB of internal Flash memory and 
8 KB of internal SRAM memory

– On-chip Ethernet Media Access Controller (EMAC) 

– 8 MB of Flash memory

– Up to 1 MB of off-chip SRAM memory 

– A USB interface that provides:

○ Power to the Board with overcurrent protection

○ Connection to the eZ80F91 MCU’s UART0 block

– DB9 connected to the eZ80F91 MCU’s UART1 block

– Optional external power connection

– Ethernet port and PHY

– Real-Time Clock support

– One 64-pin header with all available GPIO ports connected to it

• USB Smart Cable

• ZDS II Software and Documentation CD-ROM

Supported Operating Systems

The eZ80AcclaimPlus! Development Board supports the following operating systems:

• Microsoft Windows 7 (32-bit/64-bit)

• Microsoft Windows Vista (32-bit/64-bit) 

• Microsoft Windows XP 

Installing the ZDS II Software and Documentation

Prior to connecting the eZ80AcclaimPlus! Development Board to your development PC, 
locate the ZDS II CD-ROM in your eZ80AcclaimPlus! Development Kit, and observe the 
following steps to install your ZDS II software and documentation.
UM024402-0812  Kit Features
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1. Insert the ZDS II disc into the CD-ROM drive. The DemoShield installation applica-
tion should launch automatically. If DemoShield does not launch automatically, open 
Windows Explorer, browse to your CD-ROM drive, and double-click the 
launch.exe executable file to launch the DemoShield installer.

2. In the DemoShield main menu, click the Install Products button. From the list of 
products to install, you can choose to install only ZDS II or to install both ZDS II and 
all associated documentation. As an option, you can also copy the documentation 
directly from your CD-ROM drive to your hard disk.

The eZ80AcclaimPlus! Development Board is shipped with all settings at their defaults; 
these settings are listed in Table 2 on page 16. It is important to determine that the settings 
on your Board are correct before you continue with installing and running the demo.

Installing the USB Smart Cable Driver

The USB Smart Cable can be installed on PCs that run on Windows 7 (32- and 64-bit), 
Windows Vista (32- and 64-bit) and Windows XP operating systems. The procedures in 
this section will guide you through the USB Smart Cable installation process.

Windows 7 32/64 Systems

Observe the following steps to install the USB Smart Cable on a Windows 7 system.

1. Connect the USB Smart Cable to a USB port on your development PC. When the PC 
detects the new hardware, it will display the Installing device driver software dialog.

2. Windows automatically searches for the driver; this process can take a few moments. 
Because there is no option to terminate this search process, wait for the search to complete. 

If the driver was previously installed, Windows will automatically install the USB 
Smart Cable driver. If this is the case, skip ahead to Step 9. If Windows cannot find the 
driver, close the search dialog and proceed to the next step.

3. From the Start menu, navigate via the Search Programs and files menu, and enter 
Device Manager in the Search field to cause the Device Manager to appear in a list of 
search results.

4. From this search list, click Device Manager to open the Device Manager dialog, 
which presents a list of devices that operate on your PC. Find Other devices, toggle it 
to view a sublist of additional devices, and right-click your mouse on USB Smart 
Cable.

5. In the submenu that appears, click Update Driver Software....

Note:
The eZ80AcclaimPlus! Development Kit  UM024402-0812
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6. In the Update Driver Software – USB Smart Cable dialog that appears, click the 
Browse my computer for driver Software option. 

7. Click the Browse... button to browse to one of the following driver directories, 
depending on the throughput of your PC.

On 32-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x32
<ZDS II Installation CD>\device drivers\USB\x32

On 64-bit Windows 7 systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x64
<ZDS II Installation CD>\device drivers\USB\x64

8. Click Next to install the driver. On 32-bit: Windows systems, a security dialog will 
appear; select Install this driver software anyway.

9. Click Close after the Wizard finishes the installation.

Windows Vista 32/64 Systems

Observe the following steps to install the USB Smart Cable on a Windows Vista system.

1. Connect the USB Smart Cable to a USB port on the development PC.

2. After the PC detects the new hardware, it will display the Found New Hardware Wiz-
ard dialog box. Click Locate and install driver software (recommended).

3. Depending on your development PC’s User Account Control settings, Windows may 
ask for permission to continue the installation. Click Continue.

4. When the Insert the Disc dialog appears, select I don’t have the disc. Show me other 
options. Click the Next button to display the Windows couldn’t find driver dialog.

5. Select Browse my computer for driver software (advanced) to display the Browse 
For Driver dialog, which prompts you to key in or browse for the location of the driver’s 
.inf file. Depending on the type of computer you use (32- bit or 64-bit), use the 
Browse... button to navigate to one of the following paths, then click the Next button.

On 32-bit Vista systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x32
<ZDS II Installation CD>\device drivers\USB\x32

On 64-bit Vista systems, navigate to:

<ZDS II Installation Directory>\device drivers\USB\x64
<ZDS II Installation CD>\device drivers\USB\x64
UM024402-0812  Installing the USB Smart Cable Driver
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6. When the Windows Security dialog prompts you whether to install or not install, click 
Install this driver software anyway and wait until the installation is completed (Win-
dows may prompt you more than once).

7. When the software has been installed successfully, click Close.

Windows XP Systems

Observe the following steps to install the USB Smart Cable on a Windows XP system.

1. Connect the USB Smart Cable to a USB port on the development PC. When the PC 
detects the new hardware, it will display the Found New Hardware Wizard dialog.

2. In the Wizard, select Install from a list or specific location (Advanced), and click Next.

If the Windows Hardware Installation dialog appears, click Continue Anyway.

3. In the Please choose your search and installations dialog, select Search for the best 
driver in these locations and include this location in search.

4. Use the Browse... button to navigate to one of the following paths:.

<ZDS II Installation Directory>\device drivers\USB\x32

<ZDS II Installation CD>\Device Drivers\USB\x32

5. Click Next to locate the appropriate driver.

6. Click Next, then click Finish to complete the installation.

Installing the FTDI USB-to-UART Driver

An FTDI USB-to-UART driver is required to allow your PC to communicate through its 
USB port to the on-chip UART of the eZ80AcclaimPlus! MCU. Observe the following 
procedure to perform these connections.

1. Ensure that the USB cable is not plugged in to the eZ80AcclaimPlus! Development 
Board’s P3 connector.

2. Navigate to the following filepath and double-click the CDM20802_setup.exe file to 
begin the driver installation.

<CDROM>\Device Drivers\FTDI Uart

3. The installation process will begin and you should observe output similar to the fol-
lowing messages on the screen of your PC:

Note:
The eZ80AcclaimPlus! Development Kit  UM024402-0812
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32-bit OS detected
<installation path>\dpinstx86.exe
Installation driver
FTDI CDM driver installation process completed...

4. When the installation is complete, plug in the Mini-B connector of the second USB 
cable into the Board, and the larger A connector into the USB port of your PC. 

5. If the driver installation was successful, the Ports (COM & LPT) section of the Device Man-
ager will display USB Serial Port (COMx) or similar message, as highlighted in Figure 2.

To launch the Device Manager on Windows 7 systems, launch the Start menu, enter device 
manager in the Search programs and files field, and press the Enter key.

To open the Device manager on earlier Windows systems, navigate via the following path:

Start → Control Panel → System → Hardware → Device Manager → Ports (COM& LPT)

Figure 2. A Successful USB-to-UART Driver Installation

Note:
UM024402-0812  Installing the FTDI USB-to-UART Driver
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Connecting the eZ80AcclaimPlus! Development Board to 
your PC

Observe the following procedure to connect the eZ80AcclaimPlus! Board to your PC.

Disconnect or turn off the power to the eZ80AcclaimPlus! Development Board before 
connecting or disconnecting the USB Smart Cable.

1. Connect one end of the 6-circuit ribbon cable provided in your Kit to the USB Smart 
Cable unit, ensuring that the ribbon’s male connector is aligned correctly with the 
female connector on the unit, as indicated by the red stripe in Figure 3.

2. Connect the other end of the ribbon cable to Debug Connector J1 on the Development 
Board. Ensure that Pin 1 on the ribbon cable is aligned with Pin 1 on the target con-
nector, as highlighted in Figure 4.

Figure 3. Connecting the Six-Conductor Ribbon Cable to the Serial or USB Smart Cable

Caution:

 

The eZ80AcclaimPlus! Development Kit  UM024402-0812
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3. With the USB A (male) to Mini-B cable, connect Port P3 on the eZ80AcclaimPlus! 
Development Board to a USB port on the development PC to apply power to the 
Development Board, as highlighted in Figure 5.

Figure 4. Debug Connector J1

Figure 5. USB-to-UART Port 3 Connector
UM024402-0812  Connecting the eZ80AcclaimPlus! Development 
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To use the USB port as a power source, adjust the shunt on J12 to the 1–2 position.

Running the Sample Starter Project

A sample starter program provided on the ZDS II CD-ROM demonstrates how to write 
proper code for the eZ80AcclaimPlus! Development Board. The starter program is written 
so that it will default to the UART-to-USB Port P3 on the Board. The program writes a few 
character strings either to this port, or to the simulated UART output window when run-
ning the Simulator Debug Tool (see the Viewing the Starter Project Output via the ZDS II 
Instruction Set Simulator section on page 12). Before running the starter program, how-
ever, the eZ80AcclaimPlus! Development Board must be connected to your PC.

After you create your own application program, you can use ZDS II to download the code 
you created into eZ80F91 memory for testing and debugging. 

Procedure

Observe the following steps to build and run the sample starter program for viewing in a 
terminal emulation program on your PC, such as HyperTerminal.

While HyperTerminal is discussed in this document, it is not available on Windows 7 or 
Vista machines. As an alternative, consider using Tera Term, which is available for down-
load from the Internet.

1. If you haven’t already connected the UART-to-USB cable to the Board, return to the 
Connecting the eZ80AcclaimPlus! Development Board to your PC section on page 8.

2. Launch HyperTerminal. From the File menu, click New Connection.

3. In the Name field, enter a name that describes the connection.

4. In the Icon box, select an appropriate icon for your connection, then click OK.

5. In the Connect To dialog box, and from the Connect using: drop-down menu, 
choose the COM port that is connected to the UART-to-USB port on the 
eZ80AcclaimPlus! Development Board.

6. In the Port Settings dialog box, set the following options:

– Bits per second: 57600

– Data bits: 8

– Parity: None

Note:

Note:
The eZ80AcclaimPlus! Development Kit  UM024402-0812
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– Stop bits: 1

– Flow control: None

7. Click OK to establish a connection between HyperTerminal and the Board.

8. Launch ZDS II by navigating from the Windows Start menu to Programs → Zilog 
ZDS II – eZ80Acclaim! <Version> → ZDS II – eZ80Acclaim! <Version>.

9. From the File menu in ZDS II, choose Open Project, and navigate to the following 
filepath:

c:\Program Files\Zilog\ZDSII_eZ80Acclaim!_<Version>\samples\
StarterProject

10. Select the starter.zdsproj project within this filepath and click Open. A list of 
source files will appear in the Workspace panel.

11. Double-click the main.c file in the Workspace panel to open the file in ZDS II’s Edi-
tor window. Refer to the header section of the main.c file for details about the proj-
ect.

12. From the Build menu, select Set Active Configuration to open the Select Configura-
tion dialog box.

13. Select Debug, then click OK to close the Select Configuration dialog box.

14. From the Project menu in ZDS II, select Settings to open the Project Settings dialog 
box. In the Project Settings dialog box, select the Debugger page.

15. In the Debugger page, select eZ80F91ModDevKit_RAM from the Target list.

16. In the Debugger page, select USB Smart Cable from the Debug Tool drop-down 
menu.

17. Click OK to close the Project Settings dialog box.

18. If you are prompted to rebuild any affected files, click Yes. Otherwise, choose Build 
from the menu bar, then click Rebuild All.

19. To run the application, select Go from the Debug menu. Until the default settings are 
changed, the following output will be presented in the HyperTerminal window:

Zilog Developer Studio 
i = 5
d = 25
f = 1.260000
eZ80F91 5 25 1.260000
UM024402-0812  Running the Sample Starter Project



12

eZ80AcclaimPlus! Development Kit
User Manual
Viewing the Starter Project Output via the ZDS II Instruction Set 
Simulator

The eZ80Acclaim! Cycle-Accurate Instruction Set Simulator interfaces with the ZDS II 
Debugger to simulate the execution of programs without using an emulator or target hard-
ware. The Instruction Set Simulator uses the command set of the Debugger to perform 
tasks such as simulating timers and interrupts.

To use the eZ80Acclaim! Instruction Set Simulator as an option, observe the following 
steps to view the output of the starter.zdsproj project in the ZDS II IDE.

1. In ZDS II, open the starter.zdsproj project.

2. From the Project menu in ZDS II, choose Settings to open the Project Settings dialog 
box. Click the Debugger tab.

3. In the Debugger dialog, select eZ80F91ModDevKit_RAM from the Target pane by 
clicking the checkbox next to the specific target name. Next, select Simulator from 
the Debug Tool drop-down menu.

4. Click OK to close the Project Settings dialog box.

5. If you are prompted to rebuild any affected files, click Yes. Otherwise, choose Build 
from the menu bar, then click Rebuild All.

6. When the build is complete, explore the Debug toolbar’s many debugger features. To 
connect to the Simulator, choose Reset from the Debug menu.

7. Next, open the Simulated UART Output window to view the output of the program by 
navigation via the View menu to Debug Windows → Simulated UART Output.

8. To run the application, select Go from the Debug menu. Until the default settings are 
changed, the following output will be presented in the HyperTerminal window:

Zilog Developer Studio
i = 5
d = 25
f = 1.260000
eZ80F91 5 25 1.260000

9. Using the Simulator, you can now view the sample code to study how it works.
The eZ80AcclaimPlus! Development Kit  UM024402-0812
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Appendix A. eZ80AcclaimPlus! 
Development Board

The purpose of the eZ80AcclaimPlus! Development Kit is to provide a set of hardware 
and software tools for applications based on the eZ80F91 microcontroller. An image of the 
eZ80AcclaimPlus! Development Board is shown in Figure 6; see Figure 7 for a block dia-
gram.

Figure 6. The eZ80AcclaimPlus! Development Board
UM024402-0812  eZ80AcclaimPlus! Development Board
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Schematic diagrams for the eZ80AcclaimPlus! Development Board are provided in the 
Schematic Diagrams chapter on page 18.

The eZ80AcclaimPlus! Development Board is driven by the eZ80F91 MCU with an exter-
nal 50 MHz (Y1) crystal and an on-chip PLL programmed to run on the eZ80F91 MCU at 
its internal frequency of 50 MHz. The chip employs an Ethernet Media Access Controller 
(EMAC) with a Media-Independent Interface (MII) that allows the eZ80F91 MCU to it to 
interface to all available industry-standard PHYs. 

For this eZ80AcclaimPlus! implementation, the ICS1894-40 (U5) was selected to provide 
a suitable price/performance solution.

Debug connector (J1) provides access to the eZ80F91 MCU so that the user can download 
and control the execution of the sample projects provided with the Kit or his/her own proj-
ect(s) using the USB Smart Cable included in the Kit.

Figure 7. eZ80AcclaimPlus! Development Kit Block Diagram

GPIO Connector

eZ80F91
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PHY
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MAGN
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S29GL064NCY7C1049DV33-10ZSXI x 2
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400mA
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MII
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Memory

The eZ80AcclaimPlus! Development Board features the following memory configura-
tions:

• 8 KB on-chip SRAM 

• 256 KB on-chip Flash

• 1 MB off-chip SRAM; U2 and U3 are accessible by chip selects CS1 and CS2

• 8 MB off-chip Flash: U11 is accessible by chip select CS0

To learn more about the operation of the eZ80F91 MCU’s internal memory, refer to the 
eZ80F91 ASSP Product Specification (PS0270).

1. The Board features two power source options. It can be powered by connecting Port 
P3 (USB Mini-B) to the USB port of the development PC using the USB A to USB 
mini-B cable included in the Kit. The other option is to connect a female plug to an 
external 5 VDC source with at least 300–400mA of current to Port P2. A drawing of 
an optional external power supply plug is shown in Figure 8.

When the Board is powered via a USB connection, communication with the development 
PC can be established through the FT232RL chip (U8) to provide a USB-to-serial inter-
face. The UART0 block of the eZ80F91 MCU is connected to this chip.

An on-board USB port (U6) provides overcurrent protection in the event of a short or if a 
device is connected to the Board that requires more than 500 mA @3.3 V. If either condi-
tion occurs, LED2 will illuminate.

Legend
A = 3.5 mm
B = 1.3 mm
C = 6 mm or longer

Figure 8. Female Plug
UM024402-0812  Memory
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If the Board is powered via a wall outlet and P3 is not used, communication with the PC 
can be established through a DB9 female connector (P4) which is connected to the 
UART1 block of the eZ80F91 MCU.

All signals that control access to on-board memory are routed to the Board’s test points; 
please refer to Appendix B. Schematic Diagrams on page 18.

Jumper Settings

All available GPIO ports that exist on the eZ80F91 MCU are routed to connector J10, 
which is a standard 0.1"-pitch header. These signals are only routed to the odd-numbered 
pins; all even-numbered pins are connected to GND. Please refer to Appendix B. Sche-
matic Diagrams on page 18 for the exact signal connections to J10. The remaining jump-
ers are described in Table 2.

Zilog Developer Studio

The Zilog Developer Studio II Integrated Development Environment (ZDS II IDE) is a 
complete stand-alone system that provides a state-of-the-art development environment. 
Designed to run on the Windows Vista, Windows 7 and Windows XP Professional operat-

Table 2. eZ80AcclaimPlus! Development Board Jumper Settings

Jumper 
Name Description State Function

Factory 
Setting

J11 Flash WP In On-board Flash is disabled for writing.

Out On-board Flash is enabled for writing. Out

J12 Power Source 1–2 USB Powered. In

2–3 Wall Powered.

J26 RTC_VCC In RTC is powered by on-board VCC. In

Out External 3.3V source should be connected to J26.2

J25 RXD0 1–2 Pin L12 of U1 (PD1_RXD0) is connected to J10.61

2–3 Pin L12 of U1 (PD1_RXD0) is connected to U8.1 
(TXD).

In

J24 RXD1 1–2 Pin G10 of U1 (PC1_RXD1) is connected to J10.45. In

2–3 Pin G10 of U1 (PC1_RXD1) is connected to U10.12 
(R1OUT).

J23 CTS1 1–2 Pin F12 of U1 (PC3_CTS1) is connected to J10.41. In

2–3 Pin F12 of U1 (PC3_CTS1) is connected to U10.9 
(R2OUT).
Appendix A  UM024402-0812
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ing systems, ZDS II integrates a language-sensitive editor, project manager, C Compiler, 
assembler, linker, librarian and source-level symbolic debugger that supports code devel-
opment for the eZ80F91 device. For more information about ZDS II, refer to the Zilog 
Developer Studio II – eZ80Acclaim! User Manual (UM0144).

ZDS II Flash Loader Utility

The Flash Loader utility integrated within ZDS II allows a convenient way to program on-
chip Flash memory. Refer to the Zilog Developer Studio II – eZ80Acclaim! User Manual 
(UM0144) for more details.

ZDS II Sample Projects

A number of sample projects are included on the CD-ROM that ships with the 
eZ80AcclaimPlus! Development Kit. These projects, listed in Table 3, will be accessible 
upon installation.

Table 3. eZ80F910300KITG Development Kit Sample Projects

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\eZNetConfig

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\FTPClientDemo

<Installationdirectory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\MinimalConfigDemo

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\PingDemo

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\Serial2TCPDemo

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\TCPUDPDemo

<Installation directory>\ZTP\ZTP<version>_Lib\ZTP\SamplePrograms\ZTPDemo

<Installation directory>\ZTP\ZTP<version>_Lib\RZK\SamplePrograms\Bsp\SerialDemo

<Installation directory>\ZTP\ZTP<version>_Lib\RZK\SamplePrograms\Core\intrmsgq

<Installation directory>\ZTP\ZTP<version>_Lib\RZK\SamplePrograms\Core\RouterApp

<Installation directory>\ZTP\ZTP<version>_Lib\RZK\SamplePrograms\FS\FSApp

<Installation directory>\ZTP\ZTP<version>_Lib\RZK\SamplePrograms\FS\FSShell
UM024402-0812  ZDS II Flash Loader Utility

http://www.zilog.com/docs/devtools/um0144.pdf
http://www.zilog.com/docs/devtools/um0144.pdf
http://www.zilog.com/docs/devtools/um0144.pdf
http://www.zilog.com/docs/devtools/um0144.pdf
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endix B. Schematic Diagrams
Figures 9 through 12 display schematic diagrams of the eZ80AcclaimPlus! Development Board and its in

Figure 9. Schematic Diagram #1 of 4: USB and Serial Interfaces
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Figure 10. Schematic Diagram #2 of 4: EMAC Interface
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Figure 11. Schematic Diagram #3 of 4: Memory Interface
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Figure 12. Schematic Diagram #4 of 4: eZ80F91 MCU
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Appendix C. Related Documentation
The following documents are associated with the eZ80F91 MCU and are available free for 
download from the Zilog website.

• Zilog Developer Studio II – eZ80Acclaim! User Manual (UM0144)

• Zilog TCP/IP Software Suite Quick Start Guide (QS0049)

• ZTP Network Security SSL Plug-In Quick Start Guide (QS0059)

• eZ80F91 ASSP Product Specification (PS0270)
Appendix C  UM024402-0812

http://www.zilog.com/docs/devtools/um0144.pdf
http://www.zilog.com/docs/software/qs0049.pdf
http://www.zilog.com/docs/ez80acclaim/software/qs0059.pdf
http://www.zilog.com/docs/ez80acclaimplus/PS0270.pdf
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Customer Support

To share comments, get your technical questions answered, or report issues you may be 
experiencing with our products, please visit Zilog’s Technical Support page at http://sup-
port.zilog.com.

To learn more about this product, find additional documentation, or to discover other fac-
ets about Zilog product offerings, please visit the Zilog Knowledge Base or consider par-
ticipating in the Zilog Forum.

This publication is subject to replacement by a later edition. To determine whether a later 
edition exists, please visit the Zilog website at http://www.zilog.com.
UM024402-0812  

http://www.zilog.com/kb
http://www.zilog.com/forum
http://www.zilog.com


24

eZ80AcclaimPlus! Development Kit
User Manual
Customer Support  UM024402-0812


	eZ80AcclaimPlus! Development Kit
	Revision History
	Safeguards
	Table of Contents
	List of Figures
	List of Tables
	The eZ80AcclaimPlus! Development Kit
	Kit Contents
	Kit Features
	Supported Operating Systems
	Installing the ZDS II Software and Documentation
	Installing the USB Smart Cable Driver
	Windows 7 32/64 Systems
	Windows Vista 32/64 Systems
	Windows XP Systems

	Installing the FTDI USB-to-UART Driver
	Connecting the eZ80AcclaimPlus! Development Board to your PC
	Running the Sample Starter Project
	Viewing the Starter Project Output via the ZDS II Instruction Set Simulator


	Appendix A. eZ80AcclaimPlus! Development Board
	Memory
	Jumper Settings
	Zilog Developer Studio
	ZDS II Flash Loader Utility
	ZDS II Sample Projects

	Appendix B. Schematic Diagrams
	Appendix C. Related Documentation
	Customer Support


